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Introduction

The Combined Arms Training Strategy (CATS) Quick Reference Guide is presented as a "How To" guide designed to quickly familiarize training developers with the CATS functions offered in the ASAT program.  This guide includes the following topics:

· Building an action using the CATS Builder option.
· Filling in the required data for an action using the Create/Edit Actions (CATS) option.
· Creating a one-year or a two-year calendar using the Create/Edit Calendar Timeline (Plan) option.
· Using the Create/Edit Collective Task Selections option to make additions and modifications to collective tasks selections.
· Using the Create/Edit TADSS Selections option to make additions and modifications to TADSS selections.
· Printing CATS Reports using the CATS Report options. 

· Maintaining action categories using the Action Categories option.
· Arranging Collective Task Selections for the CATS Matrix report using the Sequencing Collective Task Selections option.
Included in this guide (as attachments) are annotated samples of the CATS reports and the CATS calendar.  Also included as an attachment is a brief approach to the Short Range Unit CATS Development process used by TRW.
This guide assumes that you are an experienced ASAT user and that you understand basic information about CATS Strategies.  For comprehensive information on using CATS in the ASAT program refer to Chapter 3 of the ASAT User's Guide or refer to the ASAT online help in the ASAT program.  

How to Build an Action Using the CATS Builder Option

The CATS Builder option from the ASAT Power Panel allows you to create a basic action.  An action in ASAT defines [1] who will be the focus of the training, (a TOE); [2] what will be trained, (a set of collective tasks); [3] how they will be trained, (the Action Category (exercise) type); and [4] define the Training Aids, Devices, Simulations, and Simulators 

(TADSS) to use to support the training. The 15 steps described in this section will enable you to develop a CATS action.  The following screen appears after initially selecting the CATS Builder option.
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CATS Builder Window


[image: image3.bmp]Note: Each of the six steps listed on the left pane of the CATS Builder window must be selected sequentially in order to assemble your action.  A checkmark appears next to the step once it has been completed.  The series of steps described in this section is for a Training action type.  A different set of CATS Builder steps will appear for action types other than training.

[image: image4.bmp]Tip:  In order for the pre-filter option to function properly, it is recommended that your collective tasks are up-to-date in ASAT including links for Elements/Missions, MTP/Unit Types, and Supporting Products (TADSS) which are populated at the ASAT Support Module tables.
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TOE Filter (Example 1)

Example 1, above displays a summary of the TOE information currently in your ASAT database based on a TOE filter selection.

Example 2, below displays a summary of the Mission/ARTEP/TOE information currently in your ASAT database based on a Mission/ARTEP/TOE filter selection.

Making a selection at this step does two things: (1) Selects the TOE this action will focus training on, and (2) limits the available Collective tasks to those meeting the criteria selected.
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Mission/ARTEP/TOE Filter (Example 2)
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Collective Task Selection Window

The Collective Task Selection window shown above is used to select a set of collective tasks for the action being created; this identifies what is going to be trained.  The tasks that initially appear are based on the filter selection made at the previous step.  This information is gathered from collective task data linked at the Collective Task module.  A Tasks count appears at the bottom left corner indicating the number of tasks retrieved from the ASAT database.

[image: image8.bmp]Note:
If you want to select an existing collective task selection, click the Show 

Selections button. The window shown in the next example appears.
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Show Selections Window

The Show Selections window shown above displays a list of previously created task selections.

To make a choice, highlight a selection and click the Next button.  The information 

selected will be displayed on the Collective Task Selection window shown previously

at the top of this page.
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TIP:
A "No Collective Task Selected (NCTS)" selection is automatically chosen if there are no tasks chosen for this action.  If tasks are listed and you do not want any tasks for your action, click on the Show Selections button and choose the NCTS selection.  If one or more of the collective tasks you want in this selection is not shown in the list, select the Add Others button.  This brings up the filter screen shown below used to filter the entire list of collective tasks in ASAT and to add that filtered list to the tasks selected on the current window.  

[image: image11.bmp]Note:  A Filter by Actions screen appears for the Calendar Event action type which is used to perform a similar filter function.
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Filter By Tasks Window

Any tasks matching the filter are added, unchecked, to the tasks already checked on the current window.  This keyword search can be used in conjunction with the other task filter options selected from the drop- down list boxes on the window (In MTP, Supporting Mission, and Supporting TOE). After highlighting a selection, click on one of the following three buttons:  

1. Click the OK button to add the filtered list to your list of collective tasks.

2. Click the Cancel button to cancel the filter and to return to the previous window.

3.
Click the Help button to receive help on the active window.
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Collective Task Selection Properties Window
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Select Action Category Window

The Select Action Category window shown above is used to select an action category type.  The action category identifies one of the events that could be used to train the task selection for the selected TOE.  Clicking the Show Tasks button displays the collective tasks for the task selection that supports the action category row highlighted.  The action category types are maintained in the Create/Edit Action Categories maintenance function in the CATS module. 

[image: image15.bmp]Important Note:  When creating calendar event actions you will only be able to select from action categories that are of a calendar event type in this window.  For the operational and support action types, a sustainment window appears to select the action category.

The Task Match column on this window shows how well each of the Tasks in the current selection is supported by the various Action Categories.  The values displayed are the result of links made on the Collective task tab folder under the Exercise tab.

If there are no action categories in the program, a window appears allowing you to add one.  You can also add an action category by clicking on the Add Others button.  The window shown below appears in both instances.
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Add Action Category Window

Enter data in the fields as follows:

Action Category ID:
Enter the action category identifier

Display Text:
Enter the extension name or number of the action category ID

Type:
Select from the drop down box the type of action category (Sustain, Other, or Calendar Event)

Action Category Name:
Enter an action category name

Click on the OK button to process the entry or click on the Cancel button to exit the operation without making changes.

After selecting or adding an action category type, the TADSS Selection window shown below is used to select a set of TADSS for the action being created. 
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TADSS Selection Window

The TADSS Selection window is used to select a set of TADSS for the action being created.  A TADSS count appears at the bottom left corner indicating the number of TADSS retrieved from the ASAT database.
[image: image18.bmp]Note:  If you want to select an existing TADSS selection, click the Show Selections button.  The window shown in the next example appears. 
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Show Selections Window

This window shows a list of previously created TADSS selections.  To make a choice, highlight a selection and click the Next button.  The information selected will be displayed on the TADSS Selection window shown on the previous page.


[image: image20.png]


TIP:
A "No Training Equipment (NTES)" selection is automatically chosen if there are no TADSS for this action.  If TADSS are listed and you do not want any TADSS for your action, click on the Show Selections button and choose the NTES selection.  Or, click on the Add Others Button to bring up the filter screen shown below used to filter the entire list of TADSS in ASAT and to add that filtered list to the TADSS selected on the current window.
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Filter By TADSS Window 

Any TADSS matching the filter are added, unchecked, to the TADSS already checked on the current window.  This keyword search can be used in conjunction with the other task filter options selected from the drop- down list boxes on the window (Product Type, Simulation Type, and Proponent). After highlighting a selection, click on one of the following three buttons:  

1. Click the OK button to add the filtered list to your list of collective tasks.

2. Click the Cancel button to cancel the filter and to return to the previous window.

3. Click the Help button to receive help on the active window.
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TADSS Selection Properties Window
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CATS Action Summary Window

The CATS Action Summary window, shown above, is used to complete information for the new action. 

[image: image24.bmp]Note:  The Frequency/Duration tab shown on this screen is disabled for the Support and Operational action type selections.  However, information for the Frequency/Duration tab must be completed in order for information to appear on the CATS Matrix Report (for Training and Garrison action types) or for information to appear on the Calendar (for Calendar Event action types).  

A brief description of the three tabs appearing on the CATS Action Summary window follows: 

Action Summary Tab
The Action Summary tab contains fields representing information entered for the current CATS action.  Key fields are as follows:

Field Name
Description

Echelon
This field allows the selection of an echelon to associate with the action.  A drop down selection box appears to choose a different echelon if desired.



Simulation Type

Live - Virtual - Constructive - 
This field shows the environment in which this action will predominantly be trained.



Prefill the Target Audience from the Collective Task Element Relationships (only applicable for Training Action types)

Prefill Prerequisite Collective Tasks to the Critical Gates Tables

Prefill Prerequisite Supporting Individual Tasks to the Critical Gates Tables


Check this box if you want the target audience for the action to be prefilled with the elements linked to each task within the selection. These links were made in the Training Audience tabs in the Create/Edit Actions function in CATS.

Check this box if you want the Collective Gates for the action to be prefilled with the data linked to each Collective Task within the selection.  These links were made at the Collective Module, Prerequisite Collective Task tab in ASAT.  The Prerequisite Collective Task links can be modified at the Critical Gates- Collective Gates tab in the Create/Edit Actions function in ASAT.

Check this box if you want the Individual Gates for the action to be prefilled with the data linked to each Collective Task within the selection.  These links were made at the Collective Module, Individual Task tab in ASAT.  The Individual Task links can be modified at the Critical Gates- Individual Gates tab in the Create/Edit Actions function in ASAT.



Frequency Duration Tab
The Frequency Duration tab allows the user to specify a duration and optional frequency for each training readiness level and evaluation (Internal or External) mechanism.  Key fields on this tab are as follows:

Field Name
Description
Frequency
Enter the number zero in the frequency field if the action is optional. Otherwise, enter the number of times the action must be trained annually to maintain the given readiness level.  You may enter a frequency and duration for each training level under each evaluation type.

Duration
Enter how long the exercise will last in hours.  

Description Tab
The Description tab is used to enter a descriptive summary for the current action.  

CATS Builder Button Selections

· Cancel exits the CATS Builder without saving any changes made during the current session (requires confirmation).

· Previous returns to the previous screen and leaves entries as they are on the current screen.

· Next opens the next window and moves forward in the process of building a CATS action.

· Add Others allows you to filter the entire list of Collective Tasks or TADSS in the ASAT program in order to add that filtered list to the Tasks or TADSS that are selected on the current window. 

· Invert applies only to the Task and TADSS selection steps (steps 5 and 10 on the CATS Builder window) where the checkboxes are available.  Any boxes that are checked will be cleared and any that are cleared will be checked.

· Show Selections shows a list of existing Task or TADSS selections.  This option only applies to the Task and TADSS selections (steps 6 and 11 on the CATS Builder window) when the checkbox view of these steps is visible.

· Show Items shows a list of Collective Task or TADSS.  This option only applies to the Task and TADSS selections (steps 5 and 10 on the CATS Builder window) when the Selection view is visible.

· Finish saves changes and allows you the choice of exiting to the action maintenance tab folder or exiting to the ASAT Power Panel.

· Help opens the help information for the current window.
How to Create and Edit CATS Actions
The Create/Edit Actions option from the ASAT Power Panel is used to maintain the CATS actions that exist in this ASAT database.  When this option is first selected, it provides the user with a filter window to restrict the number of actions displayed on the Action Maintenance grid shown below.
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Action Maintenance Grid

[image: image26.bmp]Note:  Inserting an action on the Action Maintenance grid will invoke the CATS Action Builder.  Deleting an action will also remove it from all Calendars that it may be a part of. 

· Key fields on this grid are as follows:

Field Name

Description
Echelon
This field displays the action echelon (field can be modified).

Simulation Type
Displays the type of training environment used in this action (field can be modified).

Quality
Displays the level of realism (fidelity) code that this training will provide.  It is measured on an A-D scale.  The lower the letter (fidelity) the more realistic the training.

A key function that can be performed at the Action Maintenance screen is the Copy Action function.  This feature is used to copy information from an existing record to a new record allowing the user to easily recreate similar data.  Clicking on the Data menu and choosing Copy Record accesses this option.  When selected, the following window appears. 
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         Copy Action

· To add text and other links to an action, from the Action Maintenance grid, click on the Data menu and choose the Related Data option or click the Related Data toolbar button  [image: image28.png]


.  This invokes the Action Maintenance Tab Folder, shown below, which provides the user access to all the data associated with a record selected previously at the Action Maintenance grid.
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Action Maintenance Tab Folder

Each of the Action Maintenance tabs are breifly described in the following table.  Refer to the online help or Chapter 3 of the ASAT User's Guide for more details on the tabs.

Action Data Tab
The Action Data tab is used to enter/edit field information.  Fields that contain data come from the CATS Builder function.  This includes action name, echelon, simulation type, and action type.  The Restrict Read drop down list box displayed on this tab is used to limit accessibility to the details of a record to only the people actively working on the record.  If the restrict read is set to yes, the record will appear in the grid view but will not allow users other than the point of contact, SME/analyst, or system administrator to open or edit the tab folder information.  These individuals are also the only persons who can set the restriction.

Readiness Tab
Training readiness is the number of training days needed to reach full proficiency for this action.  This tab allows the user to connect the current record to one or more records in another ASAT table.

Description Tab
This tab is used to provide a description on the action.  

Notes Tab
This tab is used to provide any notes regarding the action. 

*Purpose Tab
This tab is used to provide the purpose of the action.  There is no need to type the word "purpose", it is automatically entered into the Matrix report.  

*Outcome Tab
This tab is used to enter the desired outcome for the action.  There is no need to type the word "outcome", it is automatically entered into the Matrix report.  

*Execution Guidance Tab
The user can provide additional guidance concerning the execution of the action at this tab.  There is no need to type the word "execution guidance", it is automatically entered into the Matrix report.  

**Training Audience Tabs
The user can select and link which elements from the organization this action trains.  The elements selected here will determine the elements listed on the calendar for the given TOE/Readiness Level.  This tab initially displays the training audiences currently linked to the action based on the Collective Task Element links for the tasks in the task selection.  Click the View All or View Not Linked buttons to bring up a list of  all the elements from the TOE that the action is built against.  Clicking on the Related Data toolbar button [image: image30.bmp] on linked tabs accesses additional tabs used to specify the tasks in the task selection that each element will train during the action, and to specify what resource (e.g., equipment items, fuel) each element will use for the action.  Those tabs are as follows: 


(Collective Tasks tab: Specifies the collective tasks this element will train on in this action.  The list of tasks shown by the View All button consists of only those in the task selection for this action.


(Non-LIN DODIC tab: Shows what non-LIN DODIC items (such as pyrotechnics) can be linked to this element.  The list of DODIC shown by the View All button consists of only those DODIC which are not linked to any LIN in the support tables.


(LIN tab: Lists the line item numbers that can be used by the training audience for this action.  NOTE:  Element/LIN links must be made in the Element support table in order for anything to display when the View All button is pressed.


(LIN DODIC tab: Lists the DODICs that can be used by the linked Line Item Number (LIN).  NOTE:  Element/LIN links must be made in the Element support table and LIN/DODIC links in the LIN support table, in order for anything to display when the View All button is pressed.


(Duty Position tab: Lists the duty positions within this element.  If the user wants the entire element trained by this action, there are no links necessary in this tab.  NOTE:  Element/Duty Position links are required in the ASAT Support table in order for anything to display when the View All button is pressed.

**Critical Gates  Tabs
The Critical Gates tab selections presents an additional set of five tabs that provide data on the tasks that must be mastered before training on this action. Those tabs are as follows:


(Collective Gates tab:  If there was a particular prerequisite collective task to any of the tasks in the task selection, they can be linked here as collective task gates to this action.  Information here is created in the Collective module, prerequisite collective task tab.


(Drill Gates tab:  By clicking on the Related Data toolbar button  [image: image31.bmp], the user can link drill tasks at this window to drill tasks linked as supporting drill tasks to any of the tasks in the task selection in the Collective Task module.


(Individual Gates tab:  This is where the user can show the individual tasks that must be completed prior to 

the execution of the action.  Information here is created at the Collective task, Individual Task tab in the Collective module in ASAT. See note at the end of the table***


(Certification Gates tab:  This tab shows the certifications that may be required prior to the execution of the action.  This information comes from certification links to individual tasks supporting collective tasks in this action.


(Action Gates tab:  This window shows actions that must be completed prior to executing this action.  If another action has to be completed prior to beginning the current action, the user will make the link(s) here. 

Calendars Tab
This tab shows calendars that use this action in the performance of a CATS strategy. 

Terms Tab
This tab allows the user to view a list of terms and choose the term they want to have linked to the action. 

Training Facilities Tab
The Training Facilities tab allows the analyst to link a specific facility for the training.

Facility Categories Tab
The Facility Categories tab allows the user to view all the facility category options and to choose the one they want to have linked to their action. 

Multi-Echelon Training Tab
The Multi-Echelon Training tab consists of the actions that are trained concurrent with the current action, usually by subordinate and/or superior units.  User's can link the actions that can be trained concurrent to training the current action at this tab. 

**Task/TADSS Tab
This tab option allows the user to link one of the tasks in the action's task selection to one of the TADSS in the action's TADSS selection.  Click on the insert toolbar button  [image: image32.bmp] to select the data for the fields.  This data does not reappear in any of ASAT's reports. 

**Calendar Events Actions
This tab is used to link the actions to a calendar event created at the CATS Builder.  A calendar event is composed of multiple actions which allows the user to group those actions together to show concurrent execution.  This tab also allows the user to place one action onto a calendar and link the resources from all of the linked actions to that calendar.  When a calendar event is placed on the calendar, it uses all resources of the linked actions.  NOTE:  All calendar events are either No Collective Tasks Selected (NCTS) or No Training Equipment (TADSS) Selected (NTES) action types.

*     Information entered here appears on the revised CATS Matrix report.

**   This tab is disabled if the Task or TADSS selection for the current action is empty.

***  Clicking the View All button displays individual tasks that are linked to tasks in the task selection, but are either linked or unlinked to the action. 
How to Create and Modify Calendar Information
The Create/Edit Calendar Timeline option on the ASAT Power Panel is used to create or modify a calendar using the recommended plan for training for a specified training level.  A calendar can be created once you have built your CATS actions using a combination of the CATS Builder and the Action Maintenance functions.  After selecting the Create/Edit Calendar Timeline menu option, a Calendar Maintenance grid appears to enter or select calendar information as shown in the following example.
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Calendar Maintenance Grid

· Both the edit [image: image34.bmp]  and insert   [image: image35.bmp]  menu or toolbar selections will turn the background of the screen white for entering or editing information as shown in the example below.
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Calendar Maintenance Screen (Insert/Edit)

[image: image37.bmp]
Use the following procedures for making entries:

Calendar ID
Enter a unique identifier for this calendar.  Calendar Ids consist of a two-digit proponent code, a two-letter calendar identifier, and a four-digit sequence number (e.g. 6-CA-XXXX).  Entry in this field is mandatory when creating a new calendar.

Calendar Version
Enter a version number that the analyst will use to denote the newest calendar.  The latest version will have the most accurate information.  Entry in this field is mandatory when creating a new calendar. 

Status
After the analyst has completed the calendar, it will be submitted to the reviewer as a proposed calendar.  The reviewer will examine the proposed calendar and will select the new status of the calendar from the drop-down list.

TOE
Select a TOE from the drop-down list box.  The actions that will be available to build this calendar will be those built against the TOE selected.  This list is tailored to the school (i.e., the Field Artillery (FA) school will have FA TOEs).  Entry in this field is mandatory when creating a new calendar. 

Calendar Name
Enter a name that will be printed on the calendar report.

Training Readiness
Enter a training readiness code.  Training readiness relates to the number of training days needed to reach full Mission Essential Task List (METL) proficiency.  Training Readiness Level codes from the drop-down list correspond as follows:  T-1 equals 0-14 days, T-2 equals 15-28 days, T-3 equals 29-42 days, and T-4 equals 43 or more days.

· When entry is complete, select the File menu and choose the Save option.  The tab folder shown on the following page is used at this point to view or add related calendar information.  To select the tab folder, click on the Related Data toolbar button [image: image38.png]


 at the Calendar Maintenance grid or select the Data menu and choose Related Data from the menu.  
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Calendar Maintenance Tab Folder

The four tab selections are described as follows in the order they appear on the screen: 

Calendar Data
Information entered at the Calendar Maintenance screen appears on the Calendar Data tab.  Descriptions for fields that can be modified are as follows:

Field
Description
Calendar Status
Select the status category for the calendar.

Calendar Name
Enter the name associated with the calendar.

Analyst
Enter the name of the person who builds and edits the CATS strategy.

Reviewer
Enter the name of the person who supervises the analyst.

Effective Date
Enter the date the approved training calendar becomes effective.  Double-click in the white field area to get the ASAT calendar.  The ASAT calendar is used to select a date that will automatically be inserted in the field.

Published Date
Enter the date the approved training calendar becomes effective.

Start Month
Select from the drop-down list box the month the training calendar is to start.

Approval Date
Enter the date the reviewer approved the calendar.

Status Date
Enter the effective date of the calendar status.

Start Year
Enter the year the training calendar will begin.

Restrict Read
This drop down list box is used to limit accessibility to the details of a record to only the people actively working on the record.  If the restrict read is set to Yes, the record will appear in the grid view, but will not allow users other than the point of contact, SME/analyst, or system administrator to open or edit the tab folder information.  If the restrict read is set to No, users will have viewing and modification privileges as defined by the current ASAT user definition.  Only the individuals listed above can set the record restriction. 

Description Tab
The Description tab is used to enter or edit description information for the calendar. 

Notes Tab
The Notes tab is used to enter or edit a notation pertaining to the calendar.  

Actions Tab
The Actions tab presents a summary of the actions that are on the calendar.  

· After making the desired modifications or entries at the tabs, click on the File menu and choose the Save option.  Next, select the calendar option from the Data menu or click on the calendar toolbar button  [image: image40.png]


  to access the calendar.  An example of the calendar is shown and described in the following section.

How to Use the CATS Yearly Calendar

The CATS Yearly Calendar is used to create a new calendar or to edit existing calendar data for the record selected at the Calendar Maintenance function.  Select Data then Calendar from the Calendar Maintenance grid or tab folder shown in the previous section, or click on the yearly calendar toolbar [image: image41.png]


 button.  The Yearly Calendar shown in the example below appears.  The example shown is of an existing calendar.  For a new calendar, the window area would be blank.  The Calendar has four major areas:
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    CATS Yearly Calendar

· All the actions shown are linked to a certain readiness level.  For example, the tasks shown on the previous screen are for a T1 readiness level.  In the action maintenance (readiness tab), the analyst can input different frequencies and durations for different readiness levels.  You can select a different element at the Exercises For box and the corresponding actions will appear in the lower portion of the screen.
[image: image43.bmp]TIP:  When viewing information on the calendar, the user can create a split screen by pointing the mouse at the bottom of the horizontal scroll bar and dragging the split bar to the desired position.  This is useful in keeping the elements listed on the left in view while editing/scrolling to the right.


[image: image44.png]


Use the following procedures to enter information on the calendar:

Step 1.
To populate the window.  Click the mouse on an action on the lower pane and then drag the information from the lower pane to the desired position on the upper pane.  You can have multiple actions for one month/element.  On the calendar portion of the screen, a new row is added for extra (non-equal) actions.  Multiples of the same action will display a number increment before the action. 

[image: image45.bmp]Note:
The Required column in the bottom pane indicates the number of times that the selected action will have to be performed in order to obtain/maintain proficiency.  As the analyst selects the task, the overall number required to achieve proficiency is reduced as shown in the Used column.  The number of times that the action will have to be performed will depend on the information the analyst has provided in the CATS Builder or action maintenance screens.  To populate the year two calendar, select the Year 2 button and populate the actions there.

Step 2.
To copy an action from one month to another month.  Press the Control key then click the mouse and drag the action with the mouse to the desired month.

Step 3.
To move an action to another month.  Click the mouse on the action and drag the action to the desired month with the mouse.  If an action is not applicable to an element, the action cannot be added for that element.  

Step 4.
To delete a set of actions with an echelon.  Press the shift key and drag the information with the mouse to the lower portion of the window.  This also deletes multiple occurrences of the action.  To delete an action from just one element, click the left mouse button and drag the data to the lower window.

[image: image46.bmp]Note:
When moving or copying an action, the action is moved or copied for all elements that are part of the training audience for the action.  When an action/event is copied, moved, or deleted, the resources follow it or are deleted if the delete option is selected. 

Step 5.
Click the Save button on the side of the yearly calendar when the calendar is complete or select one of the other button options as follows:

· Cancel is used to exit the calendar without saving information.

· Help provides information on the current window.

· Print is used to print the current calendar.  A print option window appears from which you can select a header format (e.g., print the months as numbers or as months in a calendar) and the paper size. Note:  You must have LIN links made in order to print a report that contains resources. 

[image: image47.bmp]Additional Notes:
1. To change the current element filter for the lower window on the calendar, click the arrow next to the Exercises For box and select the new element from the drop-down list.

2. Months at the top default to numbers if no start-month is specified.  To change, click Data then Label Calendar Months on the menu. 

3. The Year 1 & Year 2 buttons toggle between showing the 1st and the 2nd year (a plan holds 2 yrs).

4. The Action Maintenance tab folder can be accessed from the calendar to view or modify an existing action.  Select the Data menu and then choose the Related Data option from the menu.  A selection done in this manner will bring up the action focused on the lower pane.  Right clicking the mouse button on a selected action on the upper pane or on an action row on the lower pane, will bring up a shortcut menu to access the Related Data option for the selection. 

5. Calendar details can be viewed by selecting a row on the lower pane and then by clicking the Data menu and choosing the Detail Data option.  A detail data screen appears for that row.  (You can also right-click the mouse button on a selected row for a shortcut menu to get to the detail data screen.)  Right clicking the mouse button on a selected action on the upper pane will bring up a shortcut menu to access the detail screen for the action selected on the upper pane.  

6. A footnote option is available to add footnote information for an action.  The footnote will appear at the bottom of the printed calendar.  This option can be selected in three ways:

· From the Data, Add/Edit footnote menu option.

· From the Footnote folder tab option on the Details screen. 

· By right-clicking the mouse on the calendar area and selecting Add/Edit Footnote from the shortcut menu. 

The presence of a footnote is designated by an asterisk (*) next to the action.  On the printed calendar, a number will appear next to the element along with a corresponding numbered footnote at the bottom of the page.

7. Clicking the View menu, Task Selection Summary option brings up a window with the total number of occurrences of a particular task selection on the calendar as well as the recommended frequency for the selection.  Clicking on the View menu, Change History option allows you to view and print the history for a selected row.

· An example of a calendar report is provided in Attachment 1 of this guide.

How to Create and Edit Collective Task Selections
The Create/Edit Collective Task option from the ASAT Power Panel allows you to use the Collective Task Selection grid and the Collective Task tab folder to add, edit, and delete collective task selections.  The collective task selections are composed of a set of collective tasks that an action trains a unit to perform.  The Collective Task Selections shown on the Collective Task grid were previously created at the CATS Builder or within this window.  A filter screen first appears before the Collective Task Selection grid displays allowing you to choose the collective task selections that will appear on the grid shown in the example below.
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Collective Task Selection Maintenance Grid

· Each record contains the following information listed in the grid columns:

Task Selection Id
Displays the Task Selection identifier.  NCTS indicates that no collective tasks are created for the action.

Task Selection Name
Displays the Task Selection name.

Annual Frequency 
This field displays the number of times per year the task selection should be trained (e.g., yearly, quarterly, monthly).

Proponent
Shows the proponent agency responsible for the task.

Last Changed
Shows the date and time the record was last changed.  This field is entered automatically.

· Click on the set of dots on the screen under the Show Tasks column to view the Collective Tasks that make up the Task Selection for the row highlighted.

· To add text and other Collective Task links to an action, from the Task Selection Maintenance grid, click the Data menu and choose the Related Data option on the menu or click the Related Data toolbar button  [image: image49.png]


.  This will bring up the Collective Task Selection Tab Folder window shown as follows.
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Collective Task Selection Tab Folder
The seven tab selections are described in the table below.

Task Selection Data Tab
The Task Selection Data tab contains details from the record selected at the Task Selection grid.  Information can be added or modified.

Description Tab
This window is used to enter a description for the Collective Task selection.

Collective Tasks Tab
The Collective Tasks tab lists the tasks that makeup the task selection.  Additional collective tasks can be linked to the task selection.   This tab is disabled for No Collective Tasks "NCTS" selections.

Actions Tab
The Actions tab shows all the actions that use this task selection.  This window is for viewing purposes only.

TOE/Elements Tab 
This tab displays all the tasks in the task selection and the TOE/Element they are linked to in the Elements/Frequency tabs in the Collective Module.  This window is for viewing purposes only.

Missions Tab
The Missions tab is similar to the TOE/Elements tab except that this tab shows how the collective tasks are linked to a mission.

Task Performance 

Support Codes(TPSC)

Tab
This tab presents a summary of various TPSC codes at the task and task step performance level on the ability of how well the TADSS supports the task.  This window is for viewing purposes only.

How to Create and Edit TADSS Selections
The Create/Edit TADSS option from the ASAT Power Panel allows you to use the TADSS Selection Maintenance grid and TADSS tab folder to add, edit, and delete Training Aids, Devices, Simulators, and Simulations (TADSS) selection records.  The TADSS selections shown on the grid consist of a set of TADSS previously created at the CATS Builder or within this grid .  Before the TADSS Maintenance grid appears, a filter screen displays to allow you to choose the TADSS selections that will appear on the TADSS maintenance grid shown in the following example.
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TADSS Selection Maintenance Grid

· Each record contains the following information listed in the grid columns:

TADSS Selection ID
Displays the TADSS identifier.  NTES indicates that no TADSS were 

created for this action.

TADSS Selection Name
Displays the TADSS name.

Proponent
Shows the proponent agency responsible for the record.

Last Changed
Shows the date and time the record was last changed.  This field is entered automatically.

· Click on the set of dots under the Show TADSS column on the screen to view the TADSS that make up the TADSS Selection for the row highlighted.

· To add text and other TADSS links to an action, click on the Data menu and choose the Related Data option or click the related data button  [image: image52.png]


. The four tabs used for the TADSS Selection Maintenance Tab Folder will appear as shown in the following example.
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TADSS Selection Tab Folder

The table below describes each tab. 

TADSS Selection Data Tab
This tab contains the details from the record selected at the TADSS maintenance grid.  The TADSS Selection Name can be added or changed.

Description Tab
This tab is used to enter a description for the TADSS record.

TADSS Tab 
This tab is used to link additional TADSS to the current selection.  Refer to section 9.4.1.3 of the ASAT User's Manual for details on linking data.  

This tab is disabled for No TADSS "NTES" Selections.

Actions Tab
This tab consists of the actions that use the current TADSS Selection. 

This option is used for for viewing purposes only.

How to Print CATS Reports

The CATS reports present the CATS data in various layouts and styles that the user may view online or print to a designated printer.  The CATS report options are accessed by clicking on the CATS module of the ASAT Power Panel and moving the vertical scroll bar to the Reports section of the menu and then double clicking on a report selection.  Five reports are available from the ASAT Power Panel described below.  Examples of the reports are provided in the attachments of this guide.  

CATS Action Summary Report (RTF)
This option produces a report that shows a summary of Training Audience information for each action by selected TOE(s). 

CATS Matrix Report (RTF)
This report lists the mission, its collective task selection with its associated collective tasks, and the exercise type information.  The report assists the user to look at the overall training strategy for a selected TOE.  The user can also print a version of the report for selected elements within a TOE, a critical gate summary, or a two-year calendar through this report option.

CATS Resource Report (RTF)
This report shows how the elements of a TOE-Unit use specific LIN(s) in the strategy for that TOE-Unit.  The report displays which actions use each selected LIN, by training years; and identifies the total hours, miles, or systems required.
Task to CATS Action Matrix (RTF)
This report is used to view a selected organization (TOE).  It shows the relationship between the tasks and the actions.

CATS Action to Element Matrix (RTF)
This report shows the relationship between the elements and the actions for a selected organization (TOE).  

Printing instructions for the five CATS reports are provided as follows:

CATS Action Summary Report (RTF)

The CATS Action Summary Report Options screen appears when the CATS Action Summary Report option is selected from the ASAT Power Panel.
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CATS Action Summary Report Options

[image: image55.bmp]Procedures for printing are described in the following four steps:

Step 1.
Choose either to view or print the RTF file.

[image: image56.bmp]TIP:  All files should be viewed before printing.  Once the file is opened in MS Word, you can always use the File\Print menu option to print the file or portions of the file if desired.

The path for storing the RTF file is displayed at the bottom of the screen.  The default is to store the file where ASAT is currently loaded on your PC.  The Browse button allows you to change the path.  If the path is changed from the default, the path will display as changed for all RTF reports generated during the current session.

After making the selections and clicking the OK button, a screen appears allowing you to select the TOEs for the report.
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Select a TOE Screen

Step 2.
Click on the checkboxes next to the TOEs you want displayed in the report. 

Step 3.
Click the OK button to generate the report for the TOE selections.  A prompt appears to confirm the completion of the report.  

Step 4.
Click OK at the prompt.  The report will appear on the screen.  If you previously clicked the print box on the Report Options Screen, the report will print to the designated printer.

CATS Matrix Report (RTF)

The CATS Matrix RTF Report Options screen appears when the CATS Matrix Report is selected from the ASAT Power Panel.
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CATS Matrix Report Option

[image: image59.bmp]Important Note:  The following five items need to be filled in the ASAT program in order to produce a CATS Matrix Report: 

1) Collective Task Selection link (which contains collective tasks)

2) TADSS Selection link (which contains TADSS)

3) A mission must be linked to an operation (in mission maintenance)

4) The Action Maintenance tab folder must have the following two items completed:

a. Training Audience link

b. Readiness level link

5)
A link must be made between elements/mission and the collective tasks

[image: image60.bmp]Procedures for printing are described in the following six steps:

Step 1.
Choose one of the options listed on the screen shown above as follows:

Revised CATS Matrix
Prints a CATS Matrix report that displays the actions built using each task selection for a selected TOE.

Revised Matrix by Element
Prints an abbreviated Matrix report that displays the actions built for selected element(s) of a TOE.

Two-Year Calendar
Prints all two-year calendar reports for a selected organization/readiness level.

Critical Gate Summary
Prints a summary of the critical gates data.  This report will filter the list of Collective Task gates to include only those performed by elements at the same echelon level or one below the element that the report is running for, where echelons are assigned for the elements.  If no echelon is assigned, gates appear automatically.  Also, if the gate is not in the collective task module, prerequisite collective task tab, the gate will appear for all audiences shown on the report.

Print RTF File
Prints the current report to the designated printer.

View RTF File
Allows you to view the report on the screen before printing.

RTF Path 
Specifies the file path of the resultant RTF file for this report.

Readiness Level
Prints a report containing the training readiness level of the desired TOE.   If a CATS contains actions for a training readiness level other than the default level displayed here (T1), the user must change to the desired readiness level here before proceeding.

Notes
Prints a report containing any notes entries made at the action maintenance tab folder. 

Step 2.
Click the OK button to process the selections or click Cancel to exit. 

[image: image61.bmp]Note:  The Browse button is used to choose the directory for the report and the Help button is used to view online help for the current window. 

· When the print criteria is executed, you will get a list of all TOE organizations available for printing as shown in the following example.
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Select a TOE Screen

Step 3.
Highlight the desired TOE and click the OK button

to continue.  An hourglass will display while the

report is being generated.  When done, the message: RTF report completed appears.   Click the OK button and the report prints onscreen or to the designated printer.

[image: image63.bmp]Note:  An additional filter screen appears, shown below, if you choose the Revised Matrix by Element option at the CATS Matrix Report Option window.  This screen allows you to select the specific elements that are to be displayed on the report.
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Element Selection Screen

Step 4.
Click on the checkboxes at this screen to select or unselect specific elements to display on the report.  The invert button is used as a toggle to remove or to choose the previous selections.  

Step 5.
Click the OK button.  An hourglass will display while the report is being generated.  The message: RTF report completed appears when the report is finished.

Step 6.
Click the OK button at the Report Completed prompt.  The report will appear on the screen.  If you previously clicked the print box on the RTF Report Options screen, the report will print to the designated printer.

CATS Resource Report  (RTF)

The CATS Resource RTF Report options screen appears when the CATS Resource report option is selected from the ASAT Power Panel.  
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CATS Resource RTF Report Options Screen

[image: image66.bmp]Procedures for printing are described in the following six steps:

Step 1.
Choose either to view or print the RTF file.

[image: image67.bmp]Note:
You must have LIN links made to the desired TOE in order to print this report. The links are made in the following three areas in ASAT.

1.
The TOE must have a LIN linked to it.  Populating the Line Item Number Equipment (LIN) table at the LIN Equipment menu option on the Support Module does this.  

2. The TOE selected for printing must be associated with a calendar.  Use the Create/Calendar Timeline menu option to create a calendar for the TOE.  

3.
The action must be linked to a LIN at the Training Audience tab under the Create/Edit Actions menu option in the CATS module.

If you add other LINS later, you will need to go to the calendar and add the LIN on the Calendar Detail tabs.

Step 2.
Click the OK button to process the selections, a Specify Filtering Criteria for TOE screen appears which allows you to specify which organizations will be displayed on the next screen.  After making the filter selection, a list of all related organizations (TOEs) in the database will display as shown in the following example.
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Select a TOE Screen

Step 3.
Highlight a selection and click the OK button to process the selection.  A screen to select the desired Training Plan (calendar) will appear as shown in the following example.
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Select a Plan Screen

Step 4.
Highlight a selection and click the OK button to process the plan selection, a new screen appears to select the desired LIN as shown in the following example.
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Select a LIN Screen

Step 5.
Highlight the selections and click the OK button to process the LIN selection.  An hourglass will display while the report is being generated.  The message: RTF report completed appears when the report is finished.

Step 6.
Click the OK button at the Report Completed prompt.   The report will display on the screen or print to the designated printer.
Task to CATS Action Matrix Report  (RTF) 

The Task to CATS Action Matrix (RTF) report option from the ASAT Power Panel produces the following RTF options window.
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RTF Report Options

[image: image72.bmp]Procedures for printing are described in the following four steps:

Step 1.
Select one of the options listed on this screen as follows:

Use Legend
Choose yes or no.  Yes uses a legend, assigning an alphabetic code to each action for a selected TOE. No puts action titles into the matrix.  The "no" selection results in fewer columns in the matrix and the matrix requiring more pages to print the report.

Print RTF File/
Choose Print RTF File to print the current report to the

View RTF File
designated printer.  Choose View RTF File to view the report on the screen before printing.

RTF Path 
Specify the file path of the resultant RTF file for this report.

Step 2.
Click OK to apply the currently selected filter criteria to the next window or click Cancel to Exit.  When the print criteria is executed, you will get a list of all TOEs available for printing as shown in the following example.

[image: image73.bmp]Note:  The Browse button allows you to choose the directory for the report and the Help button provides online help for the current window.  
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Select a TOE Screen

Step 3.
Highlight the desired TOE and press the OK button to continue.  When ASAT has generated the report, the message: RTF report completed appears.

Step 4.
Click on the OK button at the RTF Report Completed prompt.  The report will appear on the screen.  If you previously clicked the print box on the RTF Report Options screen, the report will be printed to the designated printer.

CATS Action to Element Matrix Report (RTF)

The CATS Action to Element Matrix Report option from the ASAT Power Panel produces the following window. 
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CATS Action to Element Matrix Report Options

[image: image76.bmp]Procedures for printing are the same as those for the Task to CATS Action Matrix Report described previously in this section. 

How to Create and Edit Action Categories

The Create and Edit Action Categories option from the ASAT Power Panel accesses the action categories grid and tab folder used to add, edit, and delete action categories.  This grid (shown below) displays records that have been created at the CATS Builder or within this grid.  
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Action Category Maintenance Grid

Action categories can be exercise types or sustainment/support types.  They are composed of an action category Id and one of the following action category types: sustain, exercise, calendar event, or other action category.  The Other action category type refers to an action other than an exercise, sustainment, or calendar event.  This category type usually resembles a garrison event such as “post clean-up” or “post support”.

[image: image78.bmp]Note:
Exercise types cannot be modified.

· The edit [image: image79.bmp]  and insert options [image: image80.bmp]  will turn the background of the screen white for entering or editing information.  Each record contains the following information listed in the grid columns:

Action Category ID
Displays the action category identifier

Type
Displays the type of action category 

Display Text
Displays the name or number of the action category ID

Action Category Name
Displays the action category name

· To add text and other Action Category links to an action, from the Action Category Maintenance screen, click the menu and choose the Data menu and then choose the Related Data option or click the Related Data toolbar button  [image: image81.png]


.  The Action Category Tab Folder window appears shown as follows.
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Action Categories Tab Folder

Click on the desired tab to access the information.  The four tab selections are described in the following table.

[image: image83.bmp]Note:  Information cannot be modified for Exercise types.  In addition, the Collective Tasks tab is disabled for all types except Exercise type selections. 

Action Category Data Tab
The Action Category Data tab is used to view the fields from the record selected at the Action Category grid.  This tab is a view only tab for Exercise type record selections.

Description Tab
The Description tab is used to enter or edit description information for the action category.  

Collective Tasks Tab
The Collective Tasks tab shows all the collective tasks that can be trained by the exercise (entered in the Collective Module for each Collective task).  This tab is for viewing purposes and only appears for Exercise type records.

Actions Tab
The Actions tab presents a summary of the actions using the action category.  The information on this window includes the TOE Id and name the action(s) is built for, the action name(s), the TADSS selection name used in each action, and the task selection name used in each action.

How to Sequence Collective Task Selections
The Sequence Collective Task Selections option, available under the Utilities section of the CATS Module, is used to arrange the order that the collective task selections will appear on the CATS Matrix report.  Initially, a window showing the TOEs available in the current database is displayed as shown in the following example. 
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Sequence Task Selections to TOE Selection Screen

[image: image85.bmp]Use the following four steps to sequence collective task selections.

Step 1.
Choose a TOE by selecting it with the mouse and clicking the OK button. If you click the Cancel button, the window will close without making any changes to the database, and returns to the previous window.

Once a TOE selection is made, the window example shown on the following page appears displaying a list of collective task selection records used to build actions for the selected TOE.  The task selection Id is listed on the left and the task selection name is listed on the right.
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Task Selection Sequence Screen

Step 2.
Click on a task selection.  

Step 3.
Reorder the task selection by dragging and dropping the task selection with the mouse in the desired position, or by clicking the vertical buttons on the bottom right of the window to move the selections up or down.

Step 4.
Click the OK button to close the window and save the new sequence information to the database, or click the Cancel button to close the window without making any changes to the database.

[image: image87.bmp]Note:  Reordering collective task selections on this screen will NOT affect the order in which items are displayed on the Collective Task Selection grid or tab folder.  When the user prints a CATS Matrix report, the collective task selections will be in the sequence specified at this window.


  TOE Id 03477A000

Task Selection   /   Action Category  / TADSS Selection

 Action Name 
 TA
Slice TA
LIN
DODIC
Duty Position

03-TS-2B01  /   CLASS  /   3-4-TD01

BIDS Company Headquarters Class for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)
2
0
0
0
2

03-TS-2B01  /   FTX  /   3-2-TD01

BIDS Company Headquarters FTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ) 
1
0
73
0
0

03-TS-2B01  /   LTX  /   3-2-TD01

BIDS Company Headquarters LTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)  
1
0
73
0
0

03-TS-2B01  /   STX  /   3-2-TD01

BIDS Company Headquarters STX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)  
1
0
73
0
0

03-TS-2B02  /   FTX  /   3-2-TD01

BIDS Company Headquarters/Maintenance Section FTX for Conduct Biosurveillance Operations (BIDS Company HQ) (EXEVAL)
2
0
98
2
0

03-TS-2C01  /   CLASS  /   3-4-TD01

BIDS Company Headquarters/Maintenance Section Class for Conduct Service Support Operations (Company HQ/MNT Section) 
2
0
0
0
0

03-TS-2C01  /   FTX  /   3-2-TD01

BIDS Company Headquarters/Maintenance Section FTX for Conduct Service Support Operations (Company HQ/MNT Section)  
2
0
98
0
0

03-TS-2C01  /   LTX  /   3-2-TD01

BIDS Company Headquarters/Maintenance Section LTX for Conduct Service Support Operations (Company HQ/MNT Section) 
2
0
98
0
0

03-TS-2C01  /   STX  /   3-2-TD01

BIDS Company Headquarters/Maintenance Section STX for Conduct Service Support Operations (Company HQ/MNT Section)  
2
0
98
0
0


CATS YEARLY CALENDAR (MONTHLY)

CM CO (BIO DET) (T1):  TY 1 PLAN 

Chemical Company, Biological Detection - Draft 1 (BIDS CO) - Proposed


Month:
1
2
3
4
5
6
7
8
9
10
11
12

COMPANY HEADQUARTERS
Section CLASS (Conduct Personnel Support Operations (Company HQ)) 

D (4)
Section CLASS (Conduct Service Support Operations (Company HQ/MNT Section)) 

D (4)
Section CLASS (Defend Unit Position (Company HQ/MNT Section)) 

D (4)
 
 

 
 
 
 
 
 

MAINTENANCE SECTION
 
Section CLASS (Conduct Service Support Operations (Company HQ/MNT Section)) 

D (4)
Section CLASS (Defend Unit Position (Company HQ/MNT Section)) 

D (4)
 
 
 
 
 
 
 
 
 

BIDS PLT HQ
 
 
Section CLASS (Defend Unit Position (Company HQ/MNT Section)) 

D (4)
 
 

 
 
 
 
 
 

BIDS TEAMS
 
 
 
 
 

 
 
 
 
 
 

Bold numbers in () indicates the number of hours for the event.

REVISED CATS TASK TEMPLATE

CM CO (BIO DET) (T1) 


tc "Conduct Biosurveillance Operations (BIDS Company HQ) ( 03-TS-2B02) " \l 1Task:   Conduct Biosurveillance Operations (BIDS Company HQ) ( 03-TS-2B02 )

Supporting Task(s):
03-2-3006
Secure and Defend Unit Position

03-2-3012
Plan and Initiate OPSEC Program

03-2-3016
Provide Administrative Support

03-2-3017
Establish a Field Kitchen

03-2-C312
Conduct Thorough Decontamination Operations

03-3-0007
Establish a Command Post

03-3-0008
Issue an OPORD

03-3-0009
Prepare for Operations

03-3-0013
Establish Wire Communications

03-3-C208
Cross a Radiologically Contaminated Area

03-3-C209
React to Smoke Operations

03-3-C222
Respond to the Residual Effects of a Nuclear Attack

03-3-C223
Respond to the Initial Effects of a Nuclear Attack

03-3-C224
Conduct Operational Decontamination

03-3-C226
Cross a Chemically Contaminated Area

03-4-0018
Prepare for a Biological Attack

03-4-0019
Respond to a Biological Attack

05-3-C210.03-1001
Camouflage Vehicles and Equipment

07-2-C331.03-5002
Occupy Assembly Area

08-2-0003.03-00CT
Treat Casualites

08-2-C316.03-00CT
Transport Casualties

08-2-R303.03-00CT
Conduct Battlefield Stress Reduction and Prevention Procedures

08-2-R315.03-00CT
Perform Field Sanitation Functions

09-2-C337.03-1037
React to Unexploded Ordnance

10-2-C317.03-1007
Provide Food Service Support

Frequency:   Annually ( 1) 

Types of Events:  FTX, LTX, CPX
Supported Mission(s):  


CONDUCT BIOLOGICAL SURVEILLANC


CONDUCT LRBSDS BIOLOGICAL DETE


PROVIDE BIOLOGICAL SURVEILLANC

tc "BIDS Company Headquarters/Maintenance Section FTX for Conduct Biosurveillance Operations (BIDS Company HQ) (EXEVAL) " \l 2Training Audience:  COMPANY HEADQUARTERS, MAINTENANCE SECTION






Means (Event) (TADSS):   1 - Section FTX (Company Field Training TADSS) (EXEVAL)

Title:  BIDS Company Headquarters/Maintenance Section FTX for Conduct Biosurveillance Operations  (EXEVAL)

Estimated Duration:  336  Hours

Replication of Conditions (A-D):   A - CTC training; realism sufficient to permit appraisal of training readiness for USR

Multi-echelon Training:   BIDS Platoon FTX (EXEVAL) for Conduct Biosurveillance Operations 

Critical Training Gates:  
Action Gates:  BIDS Company Headquarters Class for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ); BIDS Company Headquarters STX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)  ; BIDS Company Headquarters FTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ) ; BIDS Company Headquarters LTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)  ; BIDS Company Headquarters/Maintenance Section FTX for Conduct Biosurveillance Operations (BIDS Company HQ) (EXEVAL); BIDS Company Headquarters/Maintenance Section Class for Conduct Service Support Operations (Company HQ/MNT Section) ; BIDS Company Headquarters/Maintenance Section STX for Conduct Service Support Operations (Company HQ/MNT Section)  ; BIDS Company Headquarters/Maintenance Section FTX for Conduct Service Support Operations (Company HQ/MNT Section)  

Individual Tasks 

Resources:  

Class 3 - POL



LIN
Gal
Nomenclature



C32887
145.6
CLEANER STEAM PRESSURE JET TRAILER MOUNTED:

E70064
8.4
COMP UNIT RCP: TRK 2 WHL PNEU TIRES GAS DRVN 5 CFM 175 PSI

G11966
537.6
GEN SET: DED SKID MTD 5KW 60HZ

G12102
537.6
GEN SET: DED SKID MTD 5KW 400HZ

G18358
134.4
GEN SET: DED SKID MTD 3KW 60HZ

T60081
14.0
TRUCK CARGO: 4X4 LMTV W/E

T60149
0.1
TRUCK CARGO: 4X4 LMTV W/E W/W

T61494
28.0
TRUCK UTILITY: CARGO/TROOP CARRIER 1-1/4 TON 4X4 W/E (HMMWV)

T61908
28.0
TRUCK CARGO: MTV W/E

T73645
728.0
TRUCK LIFT FORK: CLEAN BURN DIESEL 4000 LB

T94709
0.2
TRUCK WRECKER: MTV W/E W/W

Z31804
201.6
GEN SET: SKID MTD TAC UTIL DED: LT3KW AC 60HZ

Z94047
28.0
TRUCK TANK: POL MTV W/E

Class 5 - Ammunition

DODIC
LIN
Rounds
Nomenclature



A075
M09009
300
CTG 5.56MM BLANK W/M27 LINKS (SAWS)

A080
R95035
40
CTG 5.56MM BLANK M200 F/RIFLE M16

Class 7 - Major End Items


LIN
Count
Nomenclature



C05701
2
MONITOR CHEMICAL AGENT:

C32887
1
CLEANER STEAM PRESSURE JET TRAILER MOUNTED:

C68719
8
CABLE TELEPHONE: WD-1/TT DR-8 1/2 KM

C72376
2
CASE TRANSIT MONITOR KEYBOARD GROUP: OA-9252/TYQ-33(V)

D60801
1
DIGITAL NON-SECURE VOICE TERMINAL W/DIGITAL DATA PORT: TA-1042A/

E70064
1
COMP UNIT RCP: TRK 2 WHL PNEU TIRES GAS DRVN 5 CFM 175 PSI

G11966
1
GEN SET: DED SKID MTD 5KW 60HZ

Comments:  (Includes purpose of event; outcome supported; execution guidance about execution of the event; constraints posed by TADSS/et al)
PURPOSE:
To train and evaluate the company headquarters and maintenance section on the tasks associated with conducting biosurveillance operations for an extended period of time.

OUTCOME:
The company headquarters and maintenance section can plan, prepare for, and conduct biosurveillance operations to a "run" level of proficiency for an extended period of time.

EXECUTION GUIDANCE:  This exercise trains the company at a "run" level proficiency in all tasks associated with conducting biosurveillance operations, and allows training of all company headquarters and maintenance section tasks.  This exercise also serves as an annual external evaluation of the company's operations. The company provides biosurveillance support to a higher headquarters (theatre, corps, division, and/or brigade) as it conducts continuous(day and night) operations for two weeks against a well-trained OPFOR.  This exercise can be replaced by a training rotation at a combat training center (CTC).  The higher headquarters provides all needed resources, including observer/controllers and OPFOR (if replaced by a CTC rotation, the CTC provides observer/controllers and OPFOR). The company deploys to the training area/CTC, conducts PCIs/PCCs, then conducts biosurveillance operations for the full two weeks.  Company missions are derived from controlling headquarters' OPORDS, with platoon missions resulting from company troop leading procedures.  Observer/controllers conduct AARs at appropriate intervals and provide coaching and training advice throughout the duration of the exercise.  



HHB FA BN 155SP HVY DIV3X6 / COMMAND SECTION


Field Artillery


A32060 (A)  ALARM CHEMICAL AGENT AUTO M8


QUANTITY AUTHORIZED:  0



Plan:  06-011-A3    Version:  1    Training Year:  1    Plan Name:  Training Readiness

Total OPTEMPO Allotted:   

Total Hours Planned:  317.0




OPTEMPO / TRAINING DAYS ANALYSISOOOPTMPO / TRAINING DAYS ANALYSIS


TYPE

EVENT
NUMBER

OF

SYSTEMS
FREQUENCY*
AVG

HOURS

PER

EVENT
TOTAL

HOURS
TADSS



BCT FTX
9
1 / 5
45.0
45.0
BBS, CBS, DVC-T7-88

Battalion BCT FTX
5
1 / 5
42.5
42.5


Battalion LCX
12
1 / 1
192.0
192.0


Battalion DEPEX
5
1 / 2
37.5
37.5
BBS, CBS, DVC-T7-88

TOTAL HOURS



317.0


4 
TADSS ID
TADSS NAME
000-2
COMPONENT DISPLAY BOARD, FUEL INJECTION PUMP TA

002
MAP OF AREA 1:50,000

BBS
BATTALION/BRIGADE BATTLE SIMULATION

CBS
CORPS BATTLE SIMULATION SYSTEM (V1.3)

DVC-T7-88
RIFLE M16A1 (PLASTIC)


*Frequency lists the actual frequency / required frequency for the action per year.

Action  Legend
 A
CALFEX for FIRING BATTERY/PLATOON (FIGHT):  (DELIVER FIRES) using BBS and CBS Simulation (06367L100)

 B
CALFEX for FIRING BATTERY/PLATOON (FIGHT):  (DELIVER FIRES) using BBS and CBS Simulation (06367L100)

 C
CPX for BN-SEC/CREW (FDC):  (MOVE) using Deploy CPX (06367L100)

 D
FTX for BN-SEC/CREW (HOW):  (SURVIVE) (06367L100)

 E
FTX for FIRING BATTERY/PLATOON (FIGHT):  (DELIVER FIRES) using BBS and CBS Simulation (06367L100)

 F
FTX for FIRING BATTERY/PLATOON (FIGHT):  (DELIVER FIRES) using BBS and CBS Simulation (06367L100)

 G
FTX for FIRING BATTERY/PLATOON (FIGHT):  (MOVE) (06367L100)

 H
STX for BN-SEC/CREW (FIGHT) (FDC):  (DIGITAL SUSTAINMENT) using Deploy CPX (06367L100) I
STX for FIRING BATTERY/PLATOON (FIGHT):  (COMMUNICATE) (06367L100)

 J
STX for FIRING BATTERY/PLATOON (FIGHT):  (MAINTAIN & RESUPPLY) (06367L100)

 K
STX for FIRING BATTERY/PLATOON (FIGHT):  (SURVIVE) (06367L100)

 L
TmTrng for BN- SEC/CREW (FIGHT) (AMMO):  (MOVE) (06367L100)

 M
TmTrng for BN-SEC/CREW (AMMO):  (DELIVER FIRES)  (06367L100)

 N
TmTrng for BN-SEC/CREW (FDC):  (DELIVER FIRES)  (06367L100)

 O
TmTrng for BN-SEC/CREW (HOW): (MOVE)  (06367L100)

Collective Tasks
 A
 B
 C
 D
 E
 F
 G
 H
 I
 J
 K
 L
 M
 N
 O

 Task Selection 6-2-TS301 - BN-SEC/CREW (FDC):  (DELIVER FIRES)

06-4-C000
 ESTABLISH AND MAINTAIN FDC













X


06-4-C002
 DETERMINE FIRING DATA













X


 Task Selection 6-2-TS302 - BN-SEC/CREW (AMMO):  (DELIVER FIRES)

06-1-A019
 DRAW AND TURN IN AMMUNITION (BATTALION AMMUNITION PLATOON/SECTION)












X



06-4-C005
 DISTRIBUTE AND STORE AMMUNITION (CANNON)












X



06-4-C007
 TRANSPORT AMMUNITION (BATTALION AMMO PLATOON/SECTION)












X



 Task Selection 6-2-TS400 - BN-SEC/CREW (FIGHT) (FDC):  (DIGITAL SUSTAINMENT)

06-4-C000
 ESTABLISH AND MAINTAIN FDC







X








06-4-C002
 DETERMINE FIRING DATA







X








71-3-R231.06-0001
 PERFORM RISK MANAGMENT PROCEDURES







X








 Task Selection 6-2-TS500 - BN-SEC/CREW (HOW):  (MOVE)

06-4-C008
 STORE AMMUNITION (HOWITZER SECTION)














X

71-3-R231.06-0001
 PERFORM RISK MANAGMENT PROCEDURES














X

 Task Selection 6-2-TS501 - BN-SEC/CREW (FDC):  (MOVE)

06-2-M004
 ESTABLISH AND MAINTAIN A BATTERY/PLATOON OPERATIONS CENTER (MLRS)


X













06-3-A004
 COMMAND AND CONTROL BATTERY/PLATOON/SECTION MOVEMENT OPERATIONS


X













71-3-R231.06-0001
 PERFORM RISK MANAGMENT PROCEDURES


X













CM CO (BIO DET)


 A
BIDS PLT HQ




 C
COMPANY HEADQUARTERS

 B
BIDS TEAMS




 D
MAINTENANCE SECTION


Actions
 A
 B
 C
 D

 Task Selection 03-TS-2B01 - Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)

CLASS (3-4-TD01)
BIDS Company Headquarters Class for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)
X

X


FTX (3-2-TD01)
BIDS Company Headquarters FTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)


X


LTX (3-2-TD01)
BIDS Company Headquarters LTX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)


X


STX (3-2-TD01)
BIDS Company Headquarters STX for Plan  and Monitor Biological Detection Support Operations (BIDS Company HQ)


X


 Task Selection 03-TS-2B02 - Conduct Biosurveillance Operations (BIDS Company HQ)

FTX (3-2-TD01)
BIDS Company Headquarters/Maintenance Section FTX for Conduct Biosurveillance Operations (BIDS Company HQ) (EXEVAL)


X
X

 Task Selection 03-TS-2C01 - Conduct Service Support Operations (Company HQ/MNT Section)

CLASS (3-4-TD01)
BIDS Company Headquarters/Maintenance Section Class for Conduct Service Support Operations (Company HQ/MNT Section)


X
X

FTX (3-2-TD01)
BIDS Company Headquarters/Maintenance Section FTX for Conduct Service Support Operations (Company HQ/MNT Section)


X
X

BUILDING A SHORT RANGE UNIT CATS IN ASAT

Analyst Instructions – April 2000

The purpose of this document is to provide detailed instructions for analysts who are developing short range unit Combined Arms Training Strategies (CATS) in the Automated Systems Approach to Training (ASAT) database.  In order to insure compliance with TRADOC directives and uniformity within all CATS, these instructions are directive in nature.  If any analyst desires to produce a strategy that does not conform to these instructions, he will obtain permission in advance from the CATS Project Manager for any deviation from these instructions. 

After reading these instructions, all analysts must read and understand both the CATS User’s Guide and the User’s Manual for CATS in ASAT, dated 30 Apr 98 (produced the Army Training Support Center [ATSC]).  Both of these documents are meant to assist unit trainers and training developers in their understanding of CATS and are valuable reference documents for all analysts.

After gathering necessary information from doctrinal references, appropriate TRADOC schools, and all appropriate current ASAT databases on the current state of training and training development within their unit type, each analyst will follow the outline shown below to develop their CATS.

HOW TO BUILD AN ‘ACTION’

1. An Action is defined as a Task Selection, Organization, Action Category or type, and TADSS selection.

2. Checking/addition of data.  Before going into the ASAT “CATS Builder” to build your first action, it is necessary to insure that all necessary drop down windows (ddw) and tables are filled with the required information.   Go to the “Support” section on the ASAT Power Panel.  Check the following screens to ensure that data has been entered by the proponent:


a.
TADSS.


b.
Missions.


c.
Elements.


d.
Elements/Missions.

e. TOE for the units that CATS are to be built.

To determine if TOE data is linked to Elements to support the resourcing module, open the Element screen, select the TOE of the unit you are concerned with, select an element of that TOE and check the Tab folders for LIN, Duty Position, Collective Tasks and LIN/DODIC.  If no data is available, go to the Master Data List and Export the TOE required to your working database.  Use Append – not Overwrite.

Step 1.

Select Organization and Action Type.

a.
General Comments: The first step in building a CATS action is to determine the organization type and the action type.

b.
Specific Comments: The organization type is chosen from a ddw as is the action type.  The default for action type is Training unless a Calendar Action or Garrison Action is required.  Select the Prefilter for TOE, ARTEP, Mission.  The default is all three but may restrict the tasks available for the desired action.  The less restrictive the filter, the more tasks are viewed, use the filter that best supports the action to be built.  Select NEXT.

Step 2.

Select the proper TOE, ARTEP, or Mission.

a.
General Comments: This step determines the unit TOE, the applicable ARTEP and a single mission.  The analyst should have previously determined what the appropriate missions for this unit are and will select one.  Select NEXT.

Step 3.

Determine the Task Selection to be trained.

a.
General Comments: Here is where you determine what task or tasks (called a Task Selection) will make up this action.  Multiple task selections must be supported by the Purpose, Outcome, Execution Guidance, and the Event selected to train the selection.  TADSS may be linked to specific tasks or groups of tasks in the selection and the Event may train multi-echelon or Supporting Actions.

b.
Specific Comments: Select one or more tasks from the list provided.  If the specific task or tasks you desire is/are not listed, go to the Add Others button to view other possibilities.  A filter will reduce the tasks to be viewed or select all to view all tasks in the proponent database.  Once you have selected the task or tasks, it is necessary to identify and name this Task Selection.  If it is only one task, then use the task number and name as the Task Selection ID and Name, respectively.  If this Task Selection includes more than one task, then apply the standard protocol:  _ _ - TS - _ _ _ _ (the first two digits reflect the Proponent Code, TS indicates ‘Task Selection’, the next digit reflects the Echelon Code, and the final three digits are analyst developed/random) to produce the Task Selection ID and Name.  When you identify the name you also need to identify the unit the Task Selection is for.  Specifically, at the completion of the name add, in parenthesis, the unit; for example: "Conduct Tactical Movement (Armor Company).  This is necessary to assist the reader in determining which Task Selections are relevant to which units.  Select the Annual Frequency that the task selection must be trained to maintain proficiency in the “band of excellence”, then  select O.K..

Step 4.
List the specific Event chosen to train this Task Selection.

a.
General Comments: From the list provided, select one event.

b.
Specific Comments: If the event you have chosen to train this task selection is not shown, it is necessary to back completely out of the CATS Builder, go to the “Support” section of ASAT and add the necessary event.  Then you must redo steps 2 through 7.  Events may not be added in the Training category.

Step 5.
Select a TADSS or combination of TADSS to train this Task Selection.

a.
General Comments: From the list provided, select one or more TADSS.  If no TADSS are listed select  Add Others and filter by: Product Type, Proponent or Simulation Type.  If no TADSS are required or available to support the training of the task selection the default of No TADSS Selected may be used by selecting NEXT.

b.
Specific Comments: If you select only one TADSS, simply use its name as the TADSS Selection ID and Name.  If you selected more than one TADSS, then apply the standard protocol:  _ _ - TD - _ _ _ _ (the first two digits reflect the Proponent Code, TD indicates ‘TADSS’, the next digit reflects the Echelon Code, and the final three digits are analyst developed/random) to produce the TADSS Selection ID and Name.  The current state of development of TADSS across TRADOC will require that most TADSS listed in the database be defined or further described if the analyst is not completely familiar with the acronyms and multiple listings for every training aid and device and simulation.  TADSS titles are not sufficient to determine what tasks may be trained and whether the TADSS being considered is appropriate for the event and level of training. 

Step 6.
Check and complete the Action Summary.

a.
General Comments: Check the folder called “Action Summary” to insure all the data is correct.

b.
Specific Comments: Check each entry to insure that the data shown and in the background is correct.  Add the Echelon by choosing an entry from the ddw.  Make sure it matches the echelon for which you are building this action.  If you chose one or more simulations under TADSS, select a Simulation Type (live, virtual, or constructive) from the ddw.  If you selected more than one TADSS, select the most realistic simulation type to match your selections (live first, virtual next, constructive last).  If you want to “prefill” the target audience from the Collective Task-Element linkage, check the box. 

Step 6.a.
Complete the Frequency and Duration information.

a.
General Comments: Fill in the appropriate information in the folder marked Frequency/Duration for the training of this Task Selection in this event.

b.
Specific Comments: For Active Component units, only fill in the blocks in the T-1 Readiness Level.  For Reserve Component units, fill in block for the Readiness Level at which the unit is organized and to which the unit is supposed to be trained.  Refer back to Step 6 to the number you selected for the overall annual frequency for training this task selection.  The total Frequency for training this task selection in this particular event (totaling the internal and external numbers) can not be greater than the overall annual frequency.  By placing a Frequency number in either or both columns, you are recommending to the unit commander that he conduct this many exercises of this type each year to maintain his assigned readiness level.  If you think that using this event to train this task is optional for the commander, the place a zero the Frequency block.  However, even if no Frequency was selected, a Duration for training this task in this event with this/these TADSS must still be entered.  This is strictly an estimated duration of the time it should take to train the task selection in this event.  Per guidance in FM 25-100, external evaluations are to be conducted by headquarters two levels above the evaluated unit.  If the event construction meets that criteria, then it can and should be counted as an externally evaluated event.

Step 6.b.
Do not enter anything in the Description folder.

Step 7.
Enter Finish and a prompt will ask if you want to go to the TAB Related folders.  Select Yes.

Step 8.
Check the data in the Action Maintenance Tab Folders.

a.
General Comment: Check all the data in the top half of the screen to insure it is correct.  Check the data in the bottom half in the “Action Data” folder.

b.
Specific Comments: Add the appropriate Quality Code (i.e., A, B, C, or D).  Choose the rating based on the realism of the event/TADSS combination, the accuracy of the commander’s proficiency assessment based on unit performance using this means, and the OPTEMPO cost of the means.  Realism is defined as the degree to which the cues and responses are like those in a combat environment.

1)
“A” quality means are the highest fidelity possible simulation of battle or contingency conditions for sustainment training as defined in FM 25-101.  “A” level events permit the interaction, provide the cues, and facilitate assessment of collective training to maintain peak proficiency at the coordination, integration, and if applicable, synchronization of combined arms mission execution.  “A” level events provide the greatest realism and require the greatest level of resources as reflected in figure C-1, Appendix C, FM 25-101.  CTC rotations are the best examples of “A” level events, but an event can create an equivalent level of fidelity for training tasks without being at a CTC.

2)
“B” quality means are high fidelity simulation of battle or contingency conditions at a site other than a CTC (or at home stations) for sustainment training as defined in FM 25-101.  “B” level events permit the interaction, provide the cues, and facilitate assessment of collective training to maintain peak proficiency at the coordination, integration, and if applicable, the synchronization of combined arms mission execution.  Normally “B” level events are associated with home-station training and, include OPFOR and usually, appropriate OCs to assist in assessment.

3)
“C” quality means are simulations of conditions which provide sufficient cues to facilitate collective demonstration of interaction with others to accomplish a collective task or to perform a function to standard.  Normally, “C” level events are associated with refresher training as defined in FM 25-101.  Examples of “C” level training are a seminar on mission analysis for members of an S2 section, S3 section, and the FSE, a “rock drill” of assembly area procedures for the element leaders of a unit’s field trains.

4)
“D” quality means are simulation of conditions which provide sufficient conditions to enable initial training  as defined in FM 25-101 to achieve individual or collective proficiency at part-tasks or process steps or facts or other data. An example of “D” level events is a squad’s step-by-step practice of formations before conducting drills of the same task.

Add your name as the analyst.  The analyst name must be pre-entered by the school system administrator or by agreement with the school administrator for access purposes. T he information will then be displayed in a ddw.

Step 9.
Check the data in the Readiness Tab.

a.
General Comment: Insure data linked from CATS Builder is correct.

Step 10.
The determination of the type of information to be entered in the Description Tab or how the information may be used is an open issue.

Step 11.
If you have notes that you want to appear at the bottom of the printed Action Strategy, this is where they are input.

Step 12.
Enter data into the Purpose Tab.

a.
General Comment: Add the purpose of training this task with this event with this/these TADSS.  Specific Comments: A short, concise statement of the reason why this task is being trained by this event.  Usually in the form of “To train/prepare/teach/sustain the battalion/staff group/ section...”

Step 13.
Enter data into the Outcome Tab.

a.
General Comment: Add the desired outcome of training this task.

b.
Specific Comments: The desired end result of the training activity for that task from the commander’s point of view.  Usually in the form of “The battalion/staff group/section will be able to...”

Step 14.
Enter data into the Execution Guidance Tab.

a.
General Comment: Add the execution guidance for training this task.

b.
Specific Comments: The commander’s detailed guidance/thoughts on a variety of subjects.  These may include but are not limited to: Suitability of the TADSS to support the training of the task; Need for support from higher echelons; Requirements for OPFOR, OCs, simulation center assets, training support packages, etc.; Special conditions which need to be implemented or emphasized; and Coordinating instructions for all members of the target audience.

Step 15.
Check the data in the Training Audience Tab and add additional data as needed.

a.
General Comment: Initial information in this tab is provided from linkages in selected collective tasks.  Inclusion of additional members or units to the Training Audience is accomplished by linking more units or individuals from the list of possibilities given in the Support table.

b.
Specific Comments:

1)
List the audience for training this task in this event.

2)
Include all organic, attached, and OPCON units, equipment and individuals, making sure all elements of the combined arms “slice” are listed.  Include other services as appropriate (e.g., ALO, FAC, ANGLICO). 

3)
Do not include higher units/equipment/individuals who are training aids (e.g., Division-level response cell for BCT CPX).  They should be mentioned in Step 14 (above) under Execution Guidance, when applicable. 

Step 16.
Check the data in the Critical Gates Tab and add additional data as needed.

a.
General Comment: Initial information in this tab is provided from linkages in selected collective tasks.  Inclusion of additional individual and collective gate tasks must be accomplished through the proponent collective task manager.

b.
Specific Comments:

1)
“Collective Gates” are shown in the first tab in the Critical Gates folder.  These are gates that are linked automatically to this action because of previous links with the collective tasks chosen.  Check this information to make sure it is correct.

2)
The Individual Gates tab will show all individual tasks automatically linked to the collective tasks selected.  You should check this list as well as add any additional individual tasks that need to be tied to this action as a critical gate.

3)
The Certification Gates tab should show all certifications that should be linked to this action.

4)
The Action Gates tab is the location for the analyst to add those actions that are critical prerequisites to the efficient and safe accomplishment of the action being developed.  You can not link an action that is not built yet.  For example, if you are building an action that includes TGT XII and desire to use TGT X as an Action Gate, then the action that includes TGT X must already have been built so it is available for use.  For this reason (as well as others), we need to build the Actions from bottom up, which is contrary to what most analysts have done in the past.
5)
For all of these various types of gates, the following comments apply:
a)
Focus only on critical tasks/skills.

b)
Gates are not needed for units/individuals from other services, if you do not have access to their training publications.

c)
The gates for a certain unit should become primary tasks for that unit when its strategies are being developed.  For example, gates for a company in the battalion file would become the primary (or possibly supporting) tasks for that company in its own file.

d)
It is important to give the training audience a vision of commander’s intent as to pre-STARTEX capability of all elements; that is one of the primary purposes of the gates area.

e)
Safety considerations may preclude conducting the training if proficiency gates are not met.

f)
Additionally, overall unit training will suffer if all members of the target audience do not come to the event with their training on all critical gates at the appropriate level.

Step 17.
Calendar Event Action Tab will be grayed out if no Calendar Events have been built. 

a.
General Comment: Calendar Events are built to enable the grouping of multi-echelon task selections for the purpose of the calendar.  Calendar Events will require further study to determine when and how analysts will incorporate.
Step 18.
Check the information in the Terms, Training Facilities and Facility Categories Tabs.

Step 19.
Check the data in the Supporting Actions Tab and add additional data as necessary.

a.
General Comment: This is where you would list those actions that support the training of the action being developed.  These are what we in the past had described as “Enabling tasks”.  The same problem exists if the supporting action has not yet been developed as exists if an “Action gate” has not been previously developed.

Step 20.
TADSS/Tasks folder will be grayed out unless proponent collective task manager has linked collective tasks to TADSS.

a.
General Comment: If collective tasks are linked to specific TADSS, the TADSS selection would have been provided at Step 5 in the CATS Builder and should have been included in the TADSS selection for this action.

Step 21.
Update the database.

a.
General Comment: After putting in all the required information, you must update the database.

b.
Specific Comment: Return to the Action Data folder.  Check one more time that the information shown is correct.  To update the database, you may chose one of two possibilities

1)
Go the top right of the form and select the “X” to close the window.  The system will ask you if you want to save the linked data.  Select YES.

2)
Go to the tool bar at the top of the window and select the button with the yellow arrow pointing into the green barrel.  This will update the database with your changes when you select it.

That completes the building of one CATS Action in ASAT.

HOW TO ADD ADDITIONAL EVENTS TO TRAIN

THE SAME TASK SELECTION

Step I.
Refer to your notes which show the events to be used to train this Task Selection and determine which event you will use next.

Step II.
Copy the old Action.

a.
General Comment: Use the just completed Action as your base for the new Action.

b.
Specific Comments: Go to the Power Panel.  Under CATS Development, go to the section entitled Create/Edit Actions (CATS).  When this screen is opened, there will be a Data/Copy Record option.  Copy the old Action into a new Action; insure that you check the box marked Copy linked records to have all the old links pass to the new Action.  Change the ‘Action Category ID’ to the new Event so you will be able to tell the new Action from the old one.

Step III.
Make necessary changes in the new Action.


a.
General Comment: Use the new Action format with the new Event to build your new Action.


b.
Specific Comments: Change all the information in the new Action that is not appropriate to this new Event, including all the information in the tab folders.
Plan ID





Number of Elements from the TOE linked to an Action as part of the Training Audience





Task Selections used for the Actions





Indicates that this Element is part of the Training Audience for these Actions





Actions built against this organization





The Copy Action feature allows the user to copy a record with or without the existing links or to choose individual links from the selection boxes.  After entering the information, click the OK button to process the copy or click the Cancel button to exit without making any changes.





Select the new information for the copied record from the drop-down list boxes provided.





Area 1


The Top portion of the calendar contains the record name, the menu bar options, and the toolbar buttons.  Refer to the ASAT online help for details on the selections or to the ASAT User's Guide, Chapter 3. 





Proponent Name





Collective Tasks that make up the Task Selection





TOE Number





Action Data for Actions built against this TOE





Annual Frequency for this Action (From the Action’s Readiness tab)





Number of DODICs linked to an Action in the Training Audience LIN/DODIC and Non-LIN/DODIC tab folders





Number of Individual Duty Positions linked to an Action in the Training Audience Duty Position tab folders





Event





Echelon of Action





Plan Name





Action category of action





TADSS listed above, with names 





Sum of hours for all events





Frequency of Hours





TADSS in TADSS Selection





Hours/Miles/Systems depending on LIN Usage Basis





Step 15.  Click the Finish button to save the entry.  You may be prompted if Duration information is incomplete in the Frequency/Duration tab.   If you choose to save the action, another prompt appears asking if you want to go to the Action Maintenance tab folder.  Choosing Yes will open a tab-folder containing this action.  Choosing No will return you to the Power Panel. 





The Action Maintenance tab folder provides the ability to elaborate on the information contained or related to an action, including identifying Training Audiences and resources.





OK processes the current printing selections.


Cancel allows you to exit without printing a report.


Help provides help for the active window.


Options allows you to modify the printing options you have selected for this report.


Count indicates the number of organizations (TOEs) retrieved from the program.





Training Year of Plan





Plan Version ID





Readiness Level





Annual Frequency for the Task Selection





Event Types used to train this Task Selection in this Strategy





Missions linked to the tasks in the Task Selection and the Elements in the Training Audience





Organization Name





Task Selection Name and ID





Training Audience for this Action (From the Training Audience tab)





Step 14.  Click on the desired tab to enter details for the new action.  A brief description of each of the three tab options is provided on the next page. 





Step 13.  Click the OK button to process information.  The final window used to build the action will become available shown below. 








Step 12.	Enter the TADSS information in the TADSS Selection Properties window fields as follows:


1.	TADSS Selection Id.  Enter the TADSS selection identification number.  It is recommended that the proponent code plus the letters "TA"  plus a 4 digit sequence number be used (e.g., 71-TA-1001).


2.	Proponent. Select the  proponent for the TADSS selection.


3.	TADSS Selection Name.  Enter a name for the TADSS selection.


4.	Description.  Enter a description on the set of TADSS being created.  The description displayed is made from the TADSS supporting the exercise type, the task selection, the task Id, the task name, and the TOE Id.








Quality Code.


Comes From the Action's Data tab.





Step 11.  Highlight the desired TADSS and click the Next button.  Clicking Next allows you to identify and save the new TADSS selection.  The TADSS Selection Properties window shown on the following page appears.





Note:  The TADSS Selection Properties window does not appear if an existing TADSS selection was used.








Click on the Ellipse for details on the TADSS.





Step 10.	Click on the check box next to each selection to choose TADSS items to form a selection.  Or, click the Show Selections button to choose from a list of selections previously created as shown in the example by step 11 on the next page.





Step 9.	Highlight the desired action category at the Action Category Selection window and click the Next button.  The TADSS Selection Window, shown on the following page, becomes available to continue building your action.








Step 8.  Click the OK button to process information.  The Select Action Category window used as the next step to build the action will become available as shown on the next page.





Area 2


The Upper Pane contains a time line with months (default is numeric sequence ) across the top, Training Audiences (elements) down the left side, and once entered; information on when the action(s) is trained including the duration of the event and the quality of the event.  Only one year/month of information is displayed depending on the year button chosen in the command-selection area.  When an action/event is added to the calendar, resources are automatically added based on the values set in the CATS Create/Edit Actions menu option.








Area 3


The Command-Selection 


Pane area includes the command buttons on the 


right side of the calendar window and the Exercises  


For and Year selection area between the upper and 


lower panes.





Area 4


The Lower Pane displays all the actions and events that are appropriate for the elements selected in the "Exercises For" list in the command selection area.  These elements are elements linked as training audiences for the actions built against this TOE.  The actions shown are only those identified as relevant to the readiness level of the associated plan.  





Training Audience


(elements) created at the training audience Training Audience tabs.





Strength Qty for LIN/Element





Action Data


created at the Action Maintenance screen and linked to the currently displayed element and the calendar's readiness level.





Step 7.  Enter the task information in the Collective Task Selection Properties window fields as follows:


Note:  This window does not appear if an existing selection is used.


1.	Task Selection Id.  Enter the task selection identification number for the collective task selection.  It is recommended that the Id consist of the proponent code plus the letters “TS” plus a 4 digit sequence number (e.g., 6-TS-0001).


2.	Proponent.  Select the proponent for the task selection.


3.	Task Selection Name.  Enter a name for the collective task selection which describes  the functions provided by these tasks.


4.	Annual Frequency.  Enter the number of times this task selection should be trained per year.


5.	Description.  Edit the description for the set of tasks being created.  The description statement displayed is made from the collective supporting mission Id, ARTEP Id, TOE Id, and Toe unit name.








Step 5.  Click on the check boxes on the Collective Task Selection window to choose collective tasks to form a selection.   Or, choose from a list of selections previously created by clicking the Show Selections button as shown in the example below next to step 6. 





Step 6.  After creating or choosing a Collective Task selection, click the Next button.  This allows you to identify and save the new collective task selection.  The Collective Task Selection Properties window shown on the following page appears.  





Note:  The Collective Task Selection Properties window does not appear if an existing task selection was used.








Step 4.  Highlight the desired filter selection, as shown in the two examples, and click the Next button.  The Collective Task Selection window, shown on the next page and used as the next step to build the action, becomes available.








Step 3.  Click on the Next button at the bottom of the screen to process the information.  This brings up a window to further define information for the task filter selected.  The applicable screen appears for the filter chosen at this window.  Two examples are shown on the following page.





Note:  The buttons displayed at the bottom of the windows are described in detail at the end of this section on page 11.  Buttons not applicable for a selection are disabled.





The Calendar Maintenance screen displays the calendar identification code tied to the organization.  





You can go directly to the calendar for an existing record by highlighting a row and selecting the Data menu and choosing the Calendar option or by clicking on the Calendar toolbar button � INCLUDEPICTURE "images\\calendar_toolbar.gif" \* MERGEFORMAT ���.





Come from the Action's Purpose, Outcome, and Execution Guidance tabs





Elements in the Organization (TOE)





Organization Name





From the Action’s Training Audience LIN-DODIC and Non-LIN-DODIC tabs





From the Action’s Training Audience LIN tabs





Individual Task Gates exist, but must be viewed in the ASAT Program, or printed as part of the Critical Gates Summary





Comes from the Action's Critical Gates tabs





Comes from the Action’s Multi-Echelon Training tab





Quality Code and definition (Comes from the Action’s Data tab)





The Action’s Title (from the Action’s Data tab)





Evaluation Type for this Action (From the Action’s Readiness tab)





TADSS Selection Name





Required frequency of action





See total hours below





Not in database as this time





OK processes the current printing selections.


Cancel allows you to exit without printing a report.


Help provides help for the active window.


Options allows you to modify the printing options you have selected for this report.


Count indicates the number of organizations (TOEs) retrieved from the program.





Actual frequency on calendar





Step 1.  Click on the arrow next to the organization type and the action type fields on the right pane of the CATS Builder window and choose a selection from each of the lists that appear.  The organization type defaults to the proponent choosing the program. The action type defaults to Training.  This will restrict the TOE to just those of this proponent type.








OK processes the current printing selections.


Cancel allows you to exit without printing a report.


Help provides help for the active window.


Options allows you to modify the printing options you have selected for this report.


Count indicates the number of organizations (TOEs) retrieved from the program.





Number of Elements from other TOEs linked to an Action as part of the Training Audience





  Organization (TOE)





Training Audience





OK processes the current printing selections.


Cancel allows you to exit without printing a report.


Help provides help for the active window.


Options allows you to modify the printing options you have selected for this report.


Count indicates the number of organizations (TOEs) retrieved from the program.





Quantity of LIN





Number of LINS linked to an Action in the Training Audience LIN tab folders





Echelon





Step 2.  Click on a pre-filter option displayed on the right pane of the CATS Builder window to filter the collective tasks in the database.  The four filter selections are as follows:


1.	Mission/ARTEP/TOE (collective   tasks to element/mission and collective task to MTP/unit type). 


2.	Mission/TOE (collective tasks to element/mission).


3.	ARTEP/TOE, (collective tasks to MTP/unit type, collective tasks to element/mission, and ARTEP to TOE).


TOE (collective tasks to element/mission).


Existing TOE/Task Selection  (allows you to go directly to the existing task selection window). 





Duration.  


Comes from the Action's Readiness tab.





Task Selection.


The Task Selection trained in this Action. (Information shown in parenthesis). 





Training Readiness Level. Comes from the Calendar Maintenance. Once set, it cannot be changed.








Action Echelon.


Comes from the Action’s Data tab.





Event Type.


Event Type used in this Action.





Plan Name





Training Year (1 or 2)





Organization Name





Training Audience
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